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TUTORIALS | Create a fractal landscape

ON THE CD

STAGE ONE | Creating the initial landscape

● Terragen 0.94,
Apophysis 2.02,
The Gimp 2.2
SEE PAGE 82

EXPERT TIP

i

File types
There are two important ﬁle types in
Terragen, each of which is saved and
opened separately. A TER ﬁle is the
landscape model, while the TGW ﬁle
represents the general set-up, such
as camera data, water height, clouds,
haze and the sun/lighting settings.
The TGW ﬁle also includes the
render settings for the ﬁnal image.
Since Terragen has a huge online
community, you can ﬁnd lots of prebuilt atmospheres and terrains on
the Internet, such as the terrain we’ll
make use of in the next step, which
was created by Lewis Moorcroft
(www.theartoﬂewismoorcroft.co.uk)

To create a terrain from scratch within Terragen,
click Generate Terrain in the Landscape box. A
window will open that allows us to conﬁgure our
landscape. If we hover above the value ﬁelds, we can see
information about what effect each option has. However, we
have a pre-prepared terrain, ‘ast513.ter’, which can be loaded
from the CD.
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Click Open at top of the Landscape window to load
in the ready-made terrain. With the help of the
View/Sculpt tool, we can manipulate it. We can also
use this tool to place our camera (switch between the cam
and sculpt modes with the help of the two buttons at the top
of this box).
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TERRAGEN, APOPHYSIS, THE GIMP

Fractal shores

Our exploration of the power of free software concludes with not one, but three, separate packages. Follow this
walkthrough to discover how to recreate the fractal landscape above using the tools on the CD BY CHRISTIAN HECKER

FACTFILE
FOR
Terragen, Apophysis
The Gimp

O

ver the next few pages, we’ll create the fantasy

can also be used to create swirling nebulae for a space picture. For

landscape shown above. The image was originally

the purposes of our tutorial, we’ll use it to create cloud trails that

produced as a commercial print, but we’re going

we can place in the sky above our landscape. Apophysis works like

to recreate it without spending a penny on

any other image-generating software, so this can be achieved with

software! For this, we’ll need the help of no less than three free

a minimum of fuss: there is a good selection of presets to play with,

applications. To begin with, we’ll use Terragen to create the

settings to modify the results, and a range of render-quality options.

DIFFICULTY
Elementary

landscape itself. Terragen is a wonderful 3D fractal landscape
generator that’s capable of producing impressive, eye-catching

we’ll switch applications and begin to combine the landscape and

TIME TAKEN
One hour

vistas with stunning lighting effects and moody atmospheres.

the cloud trails within the open source image-editing application

ON THE CD
• Full-size screenshots
• Terragen scene ﬁles
for the registered and
unregistered versions
of the software
• Apophysis fractal ﬁle
• The Gimp layered ﬁle

on the CD, and a more powerful commercial edition. Since we’ll be

The great thing about The Gimp is that it’s almost as powerful as

working with the free version, we’ll be somewhat restricted when

Photoshop, which means you can unleash your imagination! It’s a

it comes to adjusting quality settings. This means we can only use

solid tool with which to manipulate photos, change colours, sharpen

terrain ﬁles up to a speciﬁc level of detail, and our render output

edges or soften and blur images. With our three applications at the

resolution is limited to 1,280x960 pixels.

ready, let’s make a start.
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The Rendering Control dialog box allows us to adjust
the quality of the render (see above for optimal
settings). Click Render Settings, select the Advanced
tab and type a number that represents one third of your
installed RAM. Next, we can load our prepared world ﬁle
(World File > Open World...), ‘ast513.tgw’, which includes the
correct camera angle and atmosphere. Click Render Preview.

Lots of things have changed: there’s a better Surface
Map, and better water and atmosphere. Open the
Atmosphere box (indicated above). The atmosphere
is one of Terragen’s strengths, with self-explanatory options.
With the right settings, we can achieve wonderful sunbeams
or glowing haze and fog. There are also plenty of atmosphere
ﬁles on the Internet, so have a good look around.

Next stop, the Lighting Conditions dialog box.
This has so many available options, we could
write a whole new tutorial about them. All options
affect the behaviour of the sunlight or the atmosphere; we
can change the size of the sun with Sun’s Appearance, or the
quality of the light by using Realistic Sunlight Penetration
System and Multi-directional Shadow Lighting.

Open the Water dialog. Again, hover the mouse
above the value ﬁelds for information about each
effect. If you’re using a registered commercial
version of Terragen, avoid activating ‘extra blended detail’,
which will effectively triple the time it takes to render
without any noticeably signiﬁcant results.

We’ve skipped the Clouds dialog box, because there
are no clouds in the ﬁnal image. If you’ve changed
anything along the way, please reload ‘ast513.
tgw’. Let’s render this big: Rendering Control > Render Image.
Depending on CPU and RAM, this could take a while. Once the
render is ﬁnished, save the image by clicking the button at
the top left of the render window.
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When we’ve worked through the process of creating our fractal,

The Gimp. This is where we’ll create our beautiful, unique sky effect.

As soon as we’ve ﬁnished creating our landscape, our next
action will be to ﬁre up Apophysis, which is a simple-to-use fractal

Christian Hecker is a freelance digital artist working out of

ﬂame generator. Normally, Apophysis is used to create highly

Nuremberg, Germany. To purchase, or see more of his work,

detailed, complex and beautiful standalone fractal images, but it

visit his website at www.tigaer-design.com
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▲

ALSO REQUIRED
N/A

The software comes in two editions: the free version included

To progress with our terrain, we need to create a
Surface Map. This tool is located beneath the terrain
generator. To ﬁnd out what each button does,
brieﬂy hover the mouse over it. Click on Child to add another
texture layer, and double-click on New Surface to open the
Surface Layer window. Here, we can edit the colour and
behaviour of our texture.
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STAGE TWO | Creating a fractal

STAGE THREE (Continued) | Fitting it all together

Launch Apophysis. Immediately, the program throws
out a fractal. On the left is a list of fractal presets,
which change with each launch of Apophysis. We
can save CPU power (and time) by working with Apophysis
in this smaller window, as maximising the window means
re-rendering the picture.

With the help of the Edit tool ([Ctrl]+[E]), we
can modify angles, positions and colours of the
currently displayed fractal. Simply drag the corners
of the triangles to see immediate results. We could also use
Variation. It’s good to experiment with this setting to see
what results we can achieve.

The next helpful tool is the Adjust dialog box
([Ctrl]+[A]). Here, we can alter general settings such
as Brightness, Gamma and Vibrancy. In the lower
part of the dialog, the camera set-up can be changed; we can
zoom deeper into the fractal, or move the fractal itself into a
better position if required.

Use [Ctrl]+[G] to open the Gradient dialog box.
Here, we can change our fractal colours and adjust
presets. We’re even able to use self-made gradients.
Unfortunately, it’s almost impossible to give precise
instructions for recreating the fractal we need for the cloud
trails, so let’s open the saved ﬁle from the CD, ‘ast.ﬂame’.

This is the same fractal used in the ﬁnished
composition. It looks a bit dark right now, but we
can brighten it up with help of the Adjust dialog
that we used in step 11. Of course, we can save all of our
fractals at any time simply by using [Ctrl]+[S] to save the
fractal parameters. Now let’s output a ﬁnal render.

First, choose a path to save your rendered image (1)
and select the Size for the render (2). The Rendering
Options (3) deﬁne the quality of our render (suitable
settings are indicated in the screenshot above). The settings
marked (4) display how much RAM will be used for the render.
Once the render is under way, the bar marked (5) will reveal
how much time is left before completion.
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It’s time to ﬁre up The Gimp! Load our two rendered
images, select the window that contains our fractal
and press [Ctrl]+[C]. Then click the landscape image
and press [Ctrl]+[V]. We’ve just placed the fractal above the
landscape layer. Rename the imported layer to ‘Fractal’ and
name the Terragen layer ‘Landscape’.
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The Fractal layer is larger than the Landscape layer.
The reason for this is that we need to stretch the
Fractal layer to make it ﬁt, and the large size will
help us avoid visible layer edges. Select the Fractal layer, set
its Mode to Dodge and use the Move tool [M] to move the
fractal layer into a similar position to that shown above.
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When working with the Eraser tool, it’s easy to
erase too much, so use the History function to
undo any errors. At ﬁrst, we’ll remove those parts
of the Fractal that show up in front of our mountains. Feel
free to remove anything that you think doesn’t look right.
If the brush is too big, scale its Radius down to a value
between 25 and 40.

We have the freedom to erase what we want. The
results of our Eraser work should look something
like the image above. The sky part is almost done
and it looks great! It’s now time to add a slight reﬂection
of our sky effect to the water.

To complete our image, let’s deepen the shadows.
First, save the image [Ctrl]+[Shift]+[S] as a JPEG and
then reload it into The Gimp. We think it’s better to
use Levels to add contrast to images, as it offers much more
control over dark and bright colours. In the Levels dialog
box (to launch it, follow the screenshot above), the Auto
option delivers nice results, but to get the best results, try

it manually by moving the sliders to alter the brightness
and contrast. The left slider is for shadows, the middle one
is for general brightness/darkness, and the right one is for
the highlights. Altering the levels will dramatically alter the
appearance of the image. And that’s it! We also recommend
that you go online to check out the variety of resources at
your disposal, especially for Terragen and Apophysis. ●
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STAGE THREE | Fitting it all together
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We can use the Eraser tool [Shift]+[E] to get rid of
those parts of our Fractal layer that don’t look so
good. Right-click the Brush window and create a
new brush. This will offer much more ﬂexibility than using
a preset brush. The Gimp will switch into a menu that allows
us to freely modify it. Use the settings in the image above to
get the best results.
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Unfortunately, we now have a layer edge, but we
can stretch the Fractal layer to get rid of it. Leftclick on the image for a submenu, then go to Layer
> Scale Layer. Click on the chain icon to unlink changes in
image Width and Height (otherwise, the Height will also be
scaled in proportion), and change the Width from 1600 to
1865. Click Scale and the edge will disappear.
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Adding the reﬂection is quite a simple process.
First of all, create a copy of the Fractal layer: go
into the layer palette, right-click the Fractal layer
and Duplicate it (ensure you’ve selected the ‘Fractal copy’
layer in the palette). Go back to the image itself and turn
it around vertically (Layer > Transform > Flip Vertically).

21

With the Move tool [M] still active, we can move
‘Fractal copy’ down to the right position. We can
also use the arrow keys to move the layer (use
[Shift] to move the layer faster). Once we’ve placed the
‘Fractal copy’ layer in the right position, remove all of those
parts that show up above land. Finally, change the Opacity
of the layer to 50%.
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